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The use of the deliverables (deliverables shall include, but not limited to,  software, application examples, hardware, target boards, evaluation boards, starter kits, schematics, engineering samples of IC’s etc.) 
is subject to the terms and conditions of Spansion LLC and its affiliates (“SPANSION”) as set out below and in (i) the terms and conditions of the License Agreement and/or the Sale and Purchase Agreement 
and/or any other agreement under which deliverables have been delivered, (ii) the technical descriptions and (iii) all accompanying written materials. 
 
1. Please note that the deliverables are intended for and must only be used for test applications in an evaluation laboratory environment. 
 
2. The software deliverables are provided on an as-is basis without charge and are subject to alterations. It is the user’s obligation to fully test the software in its environment and to ensure proper 
functionality, qualification and compliance with component specifications. 
 
3. Regarding hardware deliverables, the following limited warranty shall apply: 
 
Except as otherwise provided in the following paragraphs, for a period of one (1) year from date of shipment to customer (“Warranty Period”), SPANSION warrants the hardware deliverables (i) are free of 
defects in material and workmanship, and (ii) conform to SPANSION applicable data sheet specifications (available at www.spansion.com or upon request).  
 
This warranty does not extend beyond the first purchaser of the deliverables. The liability of SPANSION under this warranty is limited, at SPANSION’s option, solely to repair the deliverable, to send 
replacement deliverable, or to make an appropriate credit adjustment or refund in an amount not to exceed the original purchase price actually paid for the deliverable returned to SPANSION. SPANSION’S 
warranty obligations are conditioned upon the following: (a) SPANSION is promptly notified in writing by customer during the applicable warranty period of any defect or nonconformance in the deliverable, 
(b) customer obtains authorization from SPANSION to return the defective deliverable, (c) the defective deliverable is returned to SPANSION in accordance with SPANSION’S shipping instructions set forth 
below, and (d) SPANSION’S examination of such deliverable discloses to its satisfaction that any defect or nonconformance actually existed and was not caused by improper use or operation outside of the 
data sheet specifications for the deliverable, abuse, negligence, improper installation, accident, loss or damage in transit, or unauthorized repair or alteration by a person other than SPANSION. Customer 
shall ship such defective deliverable to SPANSION via SPANSION’S carrier, collect. Risk of loss will transfer to SPANSION when the defective deliverable is provided to SPANSION’S carrier. If customer fails 
to adhere to these warranty returns guidelines, customer shall assume all risk of loss and shall pay for all freight to SPANSION’S specified location. This warranty shall not apply to any deliverables that have 
been repaired or altered, except those which have been repaired or altered by SPANSION. The aforementioned provisions do not extend the original warranty period of any deliverable that has either been 
repaired or replaced by Seller. 
 
THESE WARRANTIES ARE IN LIEU OF ALL OTHER WARRANTIES, EXPRESSED, IMPLIED OR STATUTORY, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS 
FOR A PARTICULAR PURPOSE, NONINFRINGEMENT, AND ANY WARRANTY OTHERWISE ARISING OUT OF ANY PROPOSAL, SPECIFICATION OR SAMPLE. SPANSION NEITHER ASSUMES NOR 
AUTHORIZES ANY OTHER PERSON TO ASSUME FOR IT ANY OTHER LIABILITIES. THE FOREGOING CONSTITUTES CUSTOMER’S SOLE AND EXCLUSIVE REMEDY FOR THE FURNISHING OF DEFECTIVE OR 
NONCONFORMING DELIVERABLES. 
 
4. The following limitation of liability shall apply for all deliverables 
 
EXCEPT FOR DAMAGES FOR BODILY INJURY OR DEATH, SPANSION SHALL NOT BE LIABLE FOR ANY INDIRECT, INCIDENTAL, SPECIAL, RELIANCE, OR CONSEQUENTIAL DAMAGES, RELIANCE 
DAMAGES, AND/OR PUNITIVE, OR EXEMPLARY DAMAGES, WHETHER ANY SUCH DAMAGES ARE BASED ON CONTRACT, TORT OR ANY OTHER LEGAL THEORY, AND WHETHER OR NOT SPANSION HAS 
BEEN INFORMED OF THE POSSIBILITY OF SUCH DAMAGES, AND NOTWITHSTANDING ANY FAILURE OF ESSENTIAL PURPOSE OF ANY LIMITED REMEDY. 
 
REGARDLESS OF THE BASIS ON WHICH CUSTOMER IS ENTITLED TO CLAIM DAMAGES FROM SPANSION (INCLUDING FUNDAMENTAL BREACH, NEGLIGENCE, MISREPRESENTATION, OR OTHER 
CONTRACT OR TORT CLAIM), SPANSION ENTIRE LIABILITY IN ANY CALENDAR YEAR, REGARDLESS OF THE NUMBER OF CLAIMS, SHALL NOT EXCEED FIFTY PERCENT (50%) OF THE TOTAL AMOUNT 
PAID BY CUSTOMER TO SPANSION FOR THE DELIVERABLES SOLD IN SUCH CALENDAR YEAR. 
 
5. Should one of the above stipulations be or become invalid and/or unenforceable, the remaining stipulations shall stay in full effect. 
 
6. The contents of this document are subject to change by SPANSION without a prior notice, thus contact SPANSION about the latest one. 
 

This board and its deliverables must only be used for test applications in an evaluation laboratory environment. 

Warranty and Disclaimer 
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Overview 

 MCU Features, Board Features & Contents 

 Test it 

 The Hardware / Pin Overview 

 The Jumper Table  / Jumper Default  

 Board Power 

 Software Examples & Tools  

 Flash Programming 

 JTAG / CMSIS-DAP 

 IAR-Embedded Workbench 

 KEIL µVision 

 Workshops, Contacts & More 

 Additional documents 
 Schematic (HW version 2.0) (1.1) 
 Data sheet MB9BD10T Series 
 Peripheral Manual (errata) 

 Timer part (errata) 
 Analog part (errata) 
 Communication part  (errata) 
 Ethernet part 

 Flash programming manual (errata) 
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Features of the microcontroller 

 SK-FM3-176PMC-ETHERNET is a versatile evaluation board based on the Spansion ARM® Cortex-M3TM device MB9BFD18T 

 The MB9BD10T Series includes the following features: 

− 32-bit ARM Cortex-M3 Core with up to 144MHz operation 

− Up to 1 Mbyte high-speed  flash memory  with true 72MHz and Flash Accelerator System 

− Up to 128Kbyte on-chip SRAM memory 

− Wide supply voltage range from 2.7 to 5.5 V 

− 2 Ethernet - MAC channels  

− 2 USB interface channels 

− 8 Multi-function Serial Interface channels (for UART, CSIO (SPI), I2C and LIN)  

− 8 DMA Controller channels 

− 3 12-bit A/D Converters, 1MSp, 32 channels max. 

− External bus interface 

− 16 Base Timer channels (PWM, PPG, reload or PWV timers selectable) 

− Up to 154 fast General Purpose I/O Ports 

− 3 Multi-function Timer units(can be used to achieve the motor control) 

− 3 Quadrature Position/Revolution Counter (QPRC) channels 

− Dual Timer (32/16bit Down Counter) 

− Resource Pin Relocation 

− Hardware Watchdog 

− CRC (Cyclic Redundancy Check) Accelerator 

− Five dynamically selectable clock sources (2 external oscillator, 2 internal CR oscillator, Main PLL) 

− Clock Supervisor (CSV) 

− Low Voltage Detector (LVD) and Low Power Mode 
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Features of the board 

 Features of the SK-FM3-176PMC-ETHERNET board: 
− Microcontroller MB9BFD18T 

− 2x Ethernet connectors 

− 2x USB-Host (Type-A connector) 

− 1x USB-Device (Type-B connector) 

− 1x USB-to-serial converter (Type-B connector) 

 UART and on-board JTAG simultaneously (version 1.1: OpenOCD, version 2.0: CMSIS DAP) 

− 1x High-speed CAN-Transceiver 

− 1x UART-Transceiver (SUB-D9 connector) 

− JTAG and Trace Interface each on a 20 pin-header 

− 2x LED-Display (7-Segment) 

− 2x pushbutton (User buttons), rotary encoder, potentiometer 

− 1x Reset-button, Reset-LED 

− All 176 pins routed to pin-header 

− On-board 5V and 3V voltage regulators to supply MCU, Power-LED 

− 4x Power supply options: USB, USB-Device, JTAG or external 8V to 12V 

− Voltage filter for ADC 

− 3x Motor-Control-Interface for e.g. SK-POWER-3P-LV2-MC 

− Multicon-Interface to connect e.g. the Fujitsu SK-TSC-1127S-SB 
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Contents SK-FM3-176PMC-ETHERNET 

 The SK-FM3-176PMC-ETHERNET box contains 

− The SK-FM3-176PMC-ETHERNET evaluation board 

− USB cable 

− CD: Documentation, software examples and development utilities 

− 1-page flyer   

ESD foam           ESD box      SK-FM3-176PMC-ETHERNET        USB cable  

                   

     CD ROM           Additional information 

  

A B 
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Test it 

 The microcontroller on the SK-FM3-176PMC-ETHERNET 
is already preprogrammed with an example application (<drive:>\Examples\mb9bf61xt_ethernet_lwip_v13.zip). 

 Connect the SK-FM3-176PMC-ETHERNET via USB (X11) with the PC 

− Verify that jumper J5 is in the USBPWR1 position 

− Switch SW1 is set to RUN 

− Press the Reset-button 

− The SK-FM3-176PMC-ETHERNET‘s display will show „00“ 

− Using pushbuttons SW3 and SW2 increase or decrease value 

 Install the USB Driver first <drive:>\drivers\driverinstaller.exe 

− Check the availibility for virtual COM port 

− e.g. Windows Device Manager 

− Open a serial terminal tool 

− e.g. Spansion Serial Port Viewer  
<drive:>\tools\serialportviewer\setup.exe 

− Settings 115200 baud, 8N1 

− Board system status is printed to the console. 

 Connect X15 (static IP address 192.168.1.20) or X16 (DHCP) to a local network 

− DHCP address can be found out via serial debug console (see above) 

− Point your webbrowser to board‘s IP address 
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Test it 

 You finished successfully the first test 

 

 

 

 Now you will get more details about the 
SK-FM3-176PMC-ETHERNET 

 

 You will learn more about  

− The on-board features 

− How to program the Flash 

− How to start with IAR-Embedded-Workbench and KEIL µVision 
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Hardware 
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The Hardware (Top Side) – Function Overview 

Trace Interface JTAG Interface 

On-board JTAG 
+ 

USB to UART B 

Multicon (I²C, SPI, UART, LIN) 

External Power 
+8V..+12V UART A CAN USB 

host 
USB 

device 
Ethernet 

port 0 
Ethernet 

port 1 

3x Motor control Interface 3x Motor control Interface 3x Motor control Interface 3x Motor control Interface 3x Motor control Interface 3x Motor control Interface 3x Motor control Interface 3x Motor control Interface 3x Motor control Interface 

7-Segment Display 

P07_1 
P07_6 

P07_3 

P07_2 P07_4 

P07_5 

P07_0 

P05_1
 
  

P05_6 

P05_3 

P05_2 P05_4 

P05_5 

P05_0 

P05_7 

SEG1: Port50-57    SEG2: Port70-77 
P07_7 

Variable resistor 

Rotary encoder 

Pushbutton 
INT10, port P7B 

Pushbutton 
INT11, port P7C 

Power 
LED 

Reset 
LED 

Reset 
button 

LD4 (yellow) 
debug run  

LD3 (red) 
debug connect 
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Hardware 

Pin-List SK-FM3-176PMC-ETHERNET (1/8) 
Pin Function Description 

1 VCC MCUVCC  

2 PA0/RTO20_0/TIOA08_0/FRCK1_0 Reset Multicon Connector / INT0 

3 PA1/RTO21_0/TIOA09_0/IC10_0 Hall Sensor1-3 /INT1 

4 PA2/RTO22_0/TIOA10_0/IC11_0 Hall Sensor1-4 

5 PA3/RTO23_0/TIOA11_0/IC12_0 Hall Sensor1-5 

6 PA4/RTO24_0/TIOA12_0/IC13_0/RX0_2/INT03_0 TINT Multicon Connector  

7 PA5/RTO25_0/TIOA13_0/TX0_2/INT10_2 GINT Multicon Connector 

8 P05/TRACED0/TIOA05_2/SIN4_2/INT00_1 UART4 ( RXD)/ TRACED0 

9 P06/TRACED1/TIOB05_2/SOT4_2/INT01_1 UART4 ( TXD)/ TRACED1 

10 P07/TRACED2/ADTG_0/SCK4_2 TRACED2 

11 P08/TRACED3/TIOA00_2/CTS4_2 CTS4/TRACED3 

12 P09/TRACECLK/TIOB00_2/RTS4_2/DTTI2X_0 RTS/TRACECLK 

13 P50/INT00_0/AIN0_2/SIN3_1/RTO10_0/IC20_0/MOEX_0 MotorDrive1 PWM1H / SEG1-A 

14 P51/INT01_0/BIN0_2/SOT3_1/RTO11_0/IC21_0/MWEX_0 MotorDrive1 PWM1L /SEG1-B 

15 P52/INT02_0/ZIN0_2/SCK3_1/RTO12_0/IC22_0/MDQM0_0 MotorDrive1 PWM2H /SEG1-C 

16 P53/SIN6_0/TIOA01_2/INT07_2/RTO13_0/IC23_0/MDQM1_0 MotorDrive1 PWM2L / SEG1-D 

17 P54/SOT6_0/TIOB01_2/RTO14_0/MALE_0 MotorDrive1 PWM3H /SEG1-E 

18 P55/SCK6_0/ADTG_1/RTO15_0/MRDY_0 MotorDrive1 PWM3L /SEG1-F 

19 P56/SIN1_0/INT08_2/TIOA09_2/DTTI1X_0/MNALE_0 MotorDrive1 FAULT /SEG1-G 

20 P57/SOT1_0/TIOB09_2/INT16_1/MNCLE_0 SEG1-DP 

21 P58/SCK1_0/TIOA11_2/INT17_1/MNWEX_0 

22 P59/SIN7_0/RX1_1/TIOB11_2/INT09_2/MNREX_0 
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Hardware 

Pin-List SK-FM3-176PMC-ETHERNET (2/8) 
Pin Function Description 

23 P5A/SOT7_0/TX1_1/TIOA13_1/INT18_1/MCSX0_0 

24 P5B/SCK7_0/TIOB13_1/INT19_1/MCSX1_0 

25 P5C/TIOA06_2/INT28_0/IC20_1 

26 P5D/TIOB06_2/INT29_0/DTTI2X_1 MotorDrive2 FAULT 

27 VSS GND 

28 P30/AIN0_0/TIOB00_1/INT03_2 QPRC0-A 

29 P31/BIN0_0/TIOB01_1/SCK6_1/INT04_2 QPRC0-B 

30 P32/ZIN0_0/TIOB02_1/SOT6_1/INT05_2 QPRC0-Z 

31 P33/INT04_0/TIOB03_1/SIN6_1/ADTG_6 

32 P34/FRCK0_0/TIOB04_1/TX0_1 CANL 

33 P35/IC03_0/TIOB05_1/RX0_1/INT08_1 CANH 

34 P36/IC02_0/SIN5_2/INT09_1/TIOA12_2/MCSX2_0 Hall Sensor0-5 

35 P37/IC01_0/SOT5_2/INT10_1/TIOB12_2/MCSX3_0 Hall Sensor0-4 

36 P38/IC00_0/SCK5_2/INT11_1/MCLKOUT_0 Hall Sensor0-3 

37 P39/DTTI0X_0/ADTG_2 MotorDrive0 FAULT 

38 P3A/RTO00_0/TIOA00_1 MotorDrive0  PWM1H 

39 P3B/RTO01_0/TIOA01_1 MotorDrive0  PWM1L 

40 P3C/RTO02_0/TIOA02_1 MotorDrive0  PWM2H 

41 P3D/RTO03_0/TIOA03_1 MotorDrive0  PWM2L 

42 P3E/RTO04_0/TIOA04_1 MotorDrive0  PWM3H 

43 P3F/RTO05_0/TIOA05_1 MotorDrive0  PWM3L 

44 VSS GND 
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Hardware 

Pin-List SK-FM3-176PMC-ETHERNET (3/8) 
Pin Function Description 

45 VCC MCUVCC 

46 P40/TIOA00_0/RTO10_1/INT12_1 

47 P41/TIOA01_0/RTO11_1/INT13_1 

48 P42/TIOA02_0/RTO12_1 

49 P43/TIOA03_0/RTO13_1/ADTG_7 

50 P44/TIOA04_0/RTO14_1 U14 LAN reset ‘nRST’ 

51 P45/TIOA05_0/RTO15_1 U12 LAN reset ‘nRST’ 

52 C C-pin 

53 VSS GND 

54 VCC MCUVCC 

55 P46/X0A Subclock (optional) 

56 P47/X1A Subclock (optional) 

57 INITX Key button ‘Reset’ 

58 P48/DTTI1X_1/INT14_1/SIN3_2 

59 P49/TIOB00_0/IC10_1/AIN0_1/SOT3_2 

60 P4A/TIOB01_0/IC11_1/BIN0_1/SCK3_2/MADATA00_0 

61 P4B/TIOB02_0/IC12_1/ZIN0_1/MADATA01_0 

62 P4C/TIOB03_0/IC13_1/SCK7_1/AIN1_2/MADATA02_0 

63 P4D/TIOB04_0/FRCK1_1/SOT7_1/BIN1_2/MADATA03_0 

64 P4E/TIOB05_0/INT06_2/SIN7_1/ZIN1_2/MADATA04_0 

65 P70/TX0_0/TIOA04_2/MADATA05_0 SEG2-A 

66 P71/RX0_0/INT13_2/TIOB04_2/MADATA06_0 SEG2-B 
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Hardware 

Pin-List SK-FM3-176PMC-ETHERNET (4/8) 
Pin Function Description 

67 P72/SIN2_0/INT14_2/AIN2_0/MADATA07_0 SEG2-C / QPRC2-A 

68 P73/SOT2_0/INT15_2/BIN2_0/MADATA08_0 SEG2-D/ QPRC2-B 

69 P74/SCK2_0/ZIN2_0/MADATA09_0 SEG2-E/ QPRC2-Z 

70 P75/SIN3_0/ADTG_8/INT07_1/MADATA10_0 SEG2-F 

71 P76/SOT3_0/TIOA07_2/INT11_2/MADATA11_0 SEG2-G 

72 P77/SCK3_0/TIOB07_2/INT12_2/MADATA12_0 SEG2-DP 

73 P78/AIN1_0/TIOA15_0/MADATA13_0 SW Rotary-A /QPRC1-A 

74 P79/BIN1_0/TIOB15_0/INT23_1/MADATA14_0 SW Rotary-B /QPRC1-B 

75 P7A/ZIN1_0/INT24_1/MADATA15_0 QPRC1-Z 

76 P7B/TIOB07_0/INT10_0 

77 P7C/TIOA07_0/INT11_0 

78 P7D/TIOA14_1/FRCK2_1/INT12_0 USB Host-Overcurrent  

79 P7E/TIOB14_1/IC21_1/INT24_0 Hall Sensor2-3 

80 P7F/TIOA15_1/IC22_1/INT25_0 Hall Sensor2-4 

81 PF0/TIOB15_1/SIN1_2/INT13_0/IC23_1 Hall Sensor2-5 / SIN Multicon Connector 

82 PF1/TIOA08_1/SOT1_2/INT14_0 SDA1 Multicon Connector 

83 PF2/TIOB08_1/SCK1_2/INT15_0 SCL1 Multicon Connector 

84 PE0/MD1 

85 MD0 Programming  Switch S1 

86 PE2/X0 4MHz Crystal 

87 PE3/X1 4MHz Crystal 

88 VSS GND 
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Hardware 

Pin-List SK-FM3-176PMC-ETHERNET (5/8) 
Pin Function Description 

89 VCC MCUVCC 

90 P10/AN00/MCSX7_0 Motor Drive0-U_DC_BUS 

91 P11/AN01/SIN1_1/INT02_1/RX1_2/FRCK0_2/MCSX6_0 Motor Drive0-U_PH_A 

92 P12/AN02/SOT1_1/TX1_2/IC00_2/MCSX5_0 Motor Drive0-U_PH_B 

93 P13/AN03/SCK1_1/IC01_2/MCSX4_0 Motor Drive0-U_PH_C 

94 P14/AN04/SIN0_1/INT03_1/IC02_2/MAD00_0 Motor Drive0-I_DC_BUS 

95 P15/AN05/SOT0_1/IC03_2/MAD01_0 Motor Drive0-I_PH_A 

96 P16/AN06/SCK0_1/INT20_1/MAD02_0 Motor Drive0-I_PH_B 

97 P17/AN07/SIN2_2/INT04_1/MAD03_0 Motor Drive0-I_PH_C 

98 P18/AN08/SOT2_2/INT21_1/MAD04_0 Motor Drive1-U_DC_BUS 

99 P19/AN09/SCK2_2/INT22_1/MAD05_0 Motor Drive1-U_PH_A 

100 P1A/AN10/SIN4_1/INT05_1/TIOA13_2/IC00_1/MAD06_0 Motor Drive1-U_PH_B 

101 P1B/AN11/SOT4_1/INT25_1/TIOB13_2/IC01_1/MAD07_0 Motor Drive1-U_PH_C 

102 P1C/AN12/SCK4_1/INT26_1/TIOA14_2/IC02_1/MAD08_0 Motor Drive1-I_DC_BUS 

103 P1D/AN13/CTS4_1/INT27_1/TIOB14_2/IC03_1/MAD09_0 Motor Drive0-I_PH_A 

104 P1E/AN14/RTS4_1/INT28_1/TIOA15_2/DTTI0X_1/MAD10_0 Motor Drive0-I_PH_B 

105 P1F/AN15/ADTG_5/INT29_1/TIOB15_2/FRCK0_1/MAD11_0 Motor Drive0-I_PH_C 

106 AVCC AVCC 

107 AVRH AVRH 

108 AVSS GND 

109 VSS GND 

110 PB0/AN16/TIOA09_1/SIN7_2/INT16_0 Motor Drive2-U_DC_BUS 
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Hardware 

Pin-List SK-FM3-176PMC-ETHERNET (6/8) 
Pin Function Description 

111 PB1/AN17/TIOB09_1/SOT7_2/INT17_0 Motor Drive2-U_PH_A 

112 PB2/AN18/TIOA10_1/SCK7_2/INT18_0 Motor Drive2-U_PH_B 

113 PB3/AN19/TIOB10_1/INT19_0 Motor Drive2-U_PH_C 

114 PB4/AN20/TIOA11_1/SIN0_2/INT20_0 Motor Drive2-I_DC_BUS 

115 PB5/AN21/TIOB11_1/SOT0_2/INT21_0/AIN2_2 Motor Drive2-I_PH_A 

116 PB6/AN22/TIOA12_1/SCK0_2/INT22_0/BIN2_2 Motor Drive2-I_PH_B 

117 PB7/AN23/TIOB12_1/INT23_0/ZIN2_2 Motor Drive2-I_PH_C 

118 P29/AN24/MAD12_0 

119 P28/AN25/ADTG_4/INT09_0/RTO05_1/MAD13_0 

120 P27/AN26/INT02_2/RTO04_1/MAD14_0 

121 P26/AN27/SCK2_1/RTO03_1/MAD15_0 

122 P25/AN28/SOT2_1/TX1_0/RTO02_1/MAD16_0 

123 P24/AN29/SIN2_1/INT01_2/RX1_0/RTO01_1/MAD17_0 

124 P23/AN30/SCK0_0/TIOA07_1/RTO00_1 Variable resistor 

125 P22/AN31/SOT0_0/TIOB07_1/ZIN1_1 UART0 ( TXD) 

126 P21/SIN0_0/INT06_1/BIN1_1 UART0 ( RXD) 

127 P20/INT05_0/CROUT_0/UHCONX1/AIN1_1/MAD18_0 

128 PF6/FRCK2_0/NMIX 

129 USBVCC1 USB- Power supply 

130 P82/UMP1 USB Data - 

131 P82/UDP1 USB Data + 

132 VSS GND 
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Hardware 

Pin-List SK-FM3-176PMC-ETHERNET (7/8) 
Pin Function Description 

133 VCC MCUVCC 

134 P00/TRSTX JTAG TRSTX 

135 P01/TCK JTAG TCK / TRACE TCK 

136 P02/TDI JTAG TDI/ TRACE TDI 

137 P03/TMS JTAG TMC/ TRACE TMC 

138 P04/TDO JTAG TMC/ TRACE TMC 

139 P90/TIOB08_0/RTO20_1/INT30_0/MAD19_0 Motor Drive2-PWM1H 

140 P91/TIOB09_0/RTO21_1/INT31_0/MAD20_0 Motor Drive2-PWM1L 

141 P92/TIOB10_0/RTO22_1/SIN5_1/MAD21_0 Motor Drive2-PWM2H 

142 P93/TIOB11_0/RTO23_1/SOT5_1/MAD22_0 Motor Drive2-PWM2L 

143 P94/TIOB12_0/RTO24_1/SCK5_1/INT26_0/MAD23_0 Motor Drive2-PWM3H 

144 P95/TIOB13_0/RTO25_1/INT27_0/MAD24_0 

145 PC0/E_RXER0_RXDV1 Ethernet 

146 PC1/E_RX03_RX11 Ethernet 

147 PC2/E_RX02_RX10 Ethernet 

148 PC3/E_RX01/TIOA06_1 Ethernet 

149 PC4/E_RX00/TIOA08_2 Ethernet 

150 PC5/E_RXDV0/TIOA10_2 Ethernet 

151 PC6/E_MDIO0/TIOA14_0 Ethernet 

152 PC7/E_MDC0/CROUT_1 Ethernet 

153 PC8/E_RXCK0_REFCK Ethernet clock 

154 PC9/E_COL0 Host/Device USB switch 
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Hardware 

Pin-List SK-FM3-176PMC-ETHERNET (8/8) 
Pin Function Description 

155 PCA/E_CRS0 
USB Host enable 

156 ETHVCC 
Ethernet VCC 

157 VSS GND 

158 PCB/E_COUT 

159 PCC/E_MDIO1 Reset Ethernet switch 

160 PCD/E_TCK0_MDC1 Ethernet 

161 PCE/E_TXER0_TXEN1/RTS4_0/TIOB06_1 Ethernet 

162 PCF/E_TX03_TX11/CTS4_0/TIOB08_2 Ethernet 

163 PD0/E_TX02_TX10/SCK4_0/TIOB10_2/INT30_1 Ethernet 

164 PD1/E_TX01/SOT4_0/TIOB14_0/INT31_1 Ethernet 

165 PD2/E_TX00/SIN4_0/TIOA03_2/INT00_2 Ethernet 

166 PD3/E_TXEN0/TIOB03_2 Ethernet 

167 P62/E_PPS0_PPS1/SCK5_0/ADTG_3 

168 P61/SOT5_0/TIOB02_2/UHCONX0 
USB UHCONX 

169 P60/SIN5_0/TIOA02_2/INT15_1 
Programming  Switch S1 

170 PF3/TIOA06_0/SIN6_2/INT06_0/AIN2_1 

171 PF4/TIOB06_0/SOT6_2/INT07_0/BIN2_1 

172 PF5/SCK6_2/INT08_0/ZIN2_1 

173 USBVCC0 
USBVCC 

174 P80/UDM0 
USB Switch 

175 P81/UDP0 
USB Switch 

176 VSS 
GND 
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The Hardware (v2.0 Top Side) – Jumper Settings 

JP42 

  
    

    
    

    

        

  
  

    

  

  

  : default position 

JP70 

JP76 

JP65 

JP46 JP40 

JP39 

JP41 JP81 

JP58 

JP56 

JP52 JP51 J5 

JP14 

JP13 

JP17 

JP18 

JP5-7 JP1-4 

JP10 

Version 2.0: 
JP47 

Board version 1.1: 
JP47-50, default closed 
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The Hardware (v2.0 Bottom Side) – Jumper Settings 

JP16 

JP71-75, JP77-80 

JP37 

JP61-64, JP66-69 

JP27 
JP28 

JP9 

JP11 

JP12 

JP8 

JP15 

JP44 

JP43 
JP45 

JP82-105 

JP19-26,JP29-36 

JP55 

JP54 

JP57 

JP53 JP60 

JP59 

JP38 
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Jumper 

Jumper Settings SK-FM3-176PMC-ETHERNET 

Number Description Special Type Default 
JP1 Main Clock Oscillator   open 
JP2 Main Clock Oscillator   open 
JP3 Main Clock Oscillator   open 
JP4 Main Clock Oscillator   open 
JP5 Sub Clock Oscillator   open 
JP6 Sub Clock Oscillator   open 
JP7 Sub Clock Oscillator   open 
JP8 C-Pin Solder Jumper closed 
JP9 C-Pin Solder Jumper closed 
JP10 USB/UART programming   open 
JP11 Sub Clock Oscillator Solder Jumper closed 
JP12 Sub Clock Oscillator Solder Jumper closed 
JP13 AVRH   closed 
JP14 AGND   closed 
JP15 Main Clock Oscillator Solder Jumper closed 
JP16 Main Clock Oscillator Solder Jumper closed 
JP17 5V/3V3   1-2 
JP18 MCUVCC   closed 

Number Description Special Type Default 
JP19 SEG1 - P50 Solder Jumper closed 
JP20 SEG1 - P51 Solder Jumper closed 
JP21 SEG1 - P52 Solder Jumper closed 
JP22 SEG1 - P53 Solder Jumper closed 
JP23 SEG1 - P54 Solder Jumper closed 
JP24 SEG1 - P55 Solder Jumper closed 
JP25 SEG1 - P56 Solder Jumper closed 
JP26 SEG1 - P57 Solder Jumper closed 
JP27 Multicon / I2C / SCL-Pullup   closed 
JP28 Multicon / I2C / SDA-Pullup   closed 
JP29 SEG2 - P70 Solder Jumper closed 
JP30 SEG2 - P71 Solder Jumper closed 
JP31 SEG2 - P72 Solder Jumper closed 
JP32 SEG2 - P73 Solder Jumper closed 
JP33 SEG2 - P74 Solder Jumper closed 
JP34 SEG2 - P75 Solder Jumper closed 
JP35 SEG2 - P76 Solder Jumper closed 
JP36 SEG2 - P77 Solder Jumper closed 
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Jumper 

Jumper Settings SK-FM3-176PMC-ETHERNET 

Number Description Special Type Default 
JP47 FTDI JTAG   closed 
JP48 FTDI JTAG   closed 
JP49 FTDI JTAG   closed 
JP50 FTDI JTAG   closed 
JP51 UART / SOT USB <-> RS232   U-0 
JP52 UART / SIN USB <-> RS232   R-1 
JP53 Flow control   open 
JP54 CTS4   open 
JP55 MAX3232 VCC Solder Jumper closed 
JP56 UART MD0 Solder Jumper open 
JP57 RTS   open 
JP58 UART-RST   open 
JP59 Flow control Solder Jumper 1-2 
JP60 Flow control Solder Jumper 2-2 
JP61 Ethernet PHY0 Solder Jumper closed 
JP62 Ethernet PHY0 Solder Jumper closed 
JP63 Ethernet PHY0 Solder Jumper closed 
JP64 Ethernet PHY0 Solder Jumper closed 

Number 
Description 

Special Type Default Version 1.1 Version 2.0 
JP37 SPI / SIN-Pin Solder Jumper open 
JP38 CAN MCUVCC / VCC5V Solder Jumper 2-3 
JP39 USBVCC0   1-2 
JP40 VBUS USBH0   2-3 
JP41 USBVCC1   1-2 
JP42 USB UHCONX   closed 
JP43 Rotary Encoder Solder Jumper closed 
JP44 Rotary Encoder Solder Jumper closed 
JP45 Potentiometer Solder Jumper closed 
JP46 VBUS USBH1   1-2 

JP47 FTDI JTAG CMSIS DAP prog   
closed/ 
v2.0:open 

JP48 FTDI JTAG Not available closed 
JP49 FTDI JTAG Not available closed 
JP50 FTDI JTAG Not available closed 
JP51 UART / SOT USB <-> RS232   U-0 
JP52 UART / SIN USB <-> RS232   R-1 
JP53 Flow control   open 
JP54 CTS4   open 
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Jumper 

Jumper Settings SK-FM3-176PMC-ETHERNET 

Number Description Special Type Default 
JP83 Motor Control 1 Solder Jumper open 
JP84 Motor Control 2 Solder Jumper open 
JP85 Motor Control 0 Solder Jumper closed 
JP86 Motor Control 1 Solder Jumper open 
JP87 Motor Control 2 Solder Jumper open 
JP88 Motor Control 0 Solder Jumper closed 
JP89 Motor Control 1 Solder Jumper open 
JP90 Motor Control 2 Solder Jumper open 
JP91 Motor Control 0 Solder Jumper closed 
JP92 Motor Control 1 Solder Jumper open 
JP93 Motor Control 2 Solder Jumper open 
JP94 Motor Control 0 Solder Jumper closed 
JP95 Motor Control 1 Solder Jumper open 
JP96 Motor Control 2 Solder Jumper open 
JP97 Motor Control 0 Solder Jumper closed 
JP98 Motor Control 1 Solder Jumper open 
JP99 Motor Control 2 Solder Jumper open 
JP100 Motor Control 0 Solder Jumper closed 

Number Description Special Type Default 
JP65 Ethernet PHY0 Reset   1-2 
JP66 Ethernet PHY0 Solder Jumper closed 
JP67 Ethernet PHY0 Solder Jumper closed 
JP68 Ethernet PHY0 Solder Jumper closed 
JP69 Ethernet PHY0 Solder Jumper closed 
JP70 Ethernet Clock Enabled   closed 
JP71 Ethernet Reference Clock Solder Jumper closed 
JP72 Ethernet PHY1 Solder Jumper closed 
JP73 Ethernet PHY1 Solder Jumper closed 
JP74 Ethernet PHY1 Solder Jumper closed 
JP75 Ethernet PHY1 Solder Jumper closed 
JP76 Ethernet PHY1 Reset   1-2 
JP77 Ethernet PHY1 Solder Jumper closed 
JP78 Ethernet PHY1 Solder Jumper closed 
JP79 Ethernet PHY1 Solder Jumper closed 
JP80 Ethernet PHY1 Solder Jumper closed 
JP81 Ethernet VCC   1-2 
JP82 Motor Control 0 Solder Jumper closed 
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Jumper – Connector selection for serial interface 

 JP51, JP52 : UART selection 

− UART0 and UART4 of the microcontroller can be used together with a 
standard RS232 SUB-D9 connector and a serial/USB converter 

− The jumpers JP51 and JP52 routes the channel to the connector 

− The interface is selected by the jumpers‘ alignment 

− UART0 = USB-connector (X11), UART4 = Sub-D9 (X12) (default) 

 Setting of Jumper JP51 and JP52: U-0 / R-4 

 
 

− UART0 = Sub-D9 (X12), UART4 = USB-connector (X11) 

 Setting of Jumper JP51 and JP52: U-4 / R-0 

 

USB RS232 

(default) 

  

USB RS232 
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Jumper – Power the starter kit and the microcontroller 

 The starter kit can be powered by 

− external power supply (8-12V) (default)  

− JLINK/JTAG connector X14 (CN3 

− USB device connector X7 

− by UART B USB connector X11 

 

 The Microcontroller can be supplied with 3.3V or 5V 

− Jumper JP17 selects MCUVCC 

− Default: JP17: 1-2 (3.3V) 
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Software 



27 © 2014 Spansion Inc.  CONFIDENTIAL 

Software Examples 

 Software examples for IAR EWARM V6.60 or KEIL µVision5.1: 
See <drive:>\Examples\ or www.spansion.com  
− mb9bfd18t_template-v16 

 ‚Empty‘ project as base for user applications 

− mb9bfxxx_ethernet-driver-v13.zip 

 Fujitsu low-level Ethernet driver 

− mb9bfxxx_ethernet_uip-v19.zip 

 Port of the free µIP (micro-IP) 
TCP/IP stack including webserver 

− mb9bfxxx_ethernet-lwip-v14.zip 

 Port of the free LwIP (Lightweight IP) TCP/IP stack 
including AJAX-enabled web application 

 

Note: Please copy the examples to your local drive before compiling! 

 

You can find a demonstration firmware and additional product information 

of the commercially supported TCP/IP stack by SEVENSTAX on this CD. 

 

http://www.spansion.com/�
http://www.sevenstax.de/�
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Software Tools 

 The following software tools are available 

− USB Virtual-COM port  

 allows UART communciation via the PC‘s USB connection 

 On-board UART-to-USB converter (via X11, CMSIS-DAP) 

 For driver installation <drive:>\drivers\driverinstaller.exe 

− FLASH USB DIRECT Programmer  

 Microcontroller Flash programming (via X7, USB-Device-Port) 

 Install from  <drive:>\tools\USBDIRECT 

− Terminal program ‚Serial Port Viewer‘ 

 Install from  <drive:>\tools\serialportviewer\setup.exe 
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Flash Programming 
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Flash Programming 

 There are several options to program the microcontroller’s flash: 
− FLASH USB DIRECT Programmer via X7 (USB device) 

 For installation <drive:>\tools\USBDIRECT\setup.exe  

 USB driver is located in subdirectory of FLASH USB DIRECT Programmer  

− FLASH MCU Programmer via X11 (Serial via UART A or UART B) 

 For installation <drive:>\tools\PCWFM3-V01L07\setup.exe  

 For driver installation of USB/Virtual-COM port 
v2.0: <drive:>\drivers\driverinstaller.exe 

 v1.1: Spansion OpenOCD Starter -> button „Install driver“ 

− JTAG Programming via X11 (v2.0: CMSIS-DAP, v1.1: OpenOCD) 

 Example is given for IAR and KEIL 

 See documentation of your development suite how to setup CMSIS-DAP 

− JTAG Programming via X14 (optional JTAG adapter) 

 The correct JTAG-adapter must be selected in the IDE toolchain  
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Flash Programming via X7 (USB direct) 

 FLASH USB DIRECT Programming via X7 (USB device) 
− Jumper Setting 
 Select the MCU power supply (J5) 

 Close JP10 

 Set switch S1 to position PROG 

− Connect USB port X7 with the PC  
− If connected for first time Windows OS may ask for a driver 
 See subfolder ‚driver‘ of USBdirect installation path 

or <drive:>\tools\USBDIRECT\driver 

− Start the FLASH USB DIRECT Programmer 
 For first installation: <drive:>\tools\USBDIRECT\setup.exe 

 Select the COM port  

 Press Reset 

 Start Full Operation 

 Set switch S1 to position RUN 

 Press Reset 
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Flash Programming via X7 (USB device) 

 Choose the right target MCU MB9BFD18S/T 

 Browse for the programming file (*.srec or *.hex) 
− IAR: see subfolder <project>\example\IAR\output\release\exe 

− ARM/KEIL: see subfolder <project>\example\ARM\output\release 

 Adjust the corresponding virtual COM-port 

 

 

 Use ‚Full Operation‘ 
− Download kernel 

− Erase Flash memory / Blank check 

− Program & Verify project to Flash memory 

 Set switch S1 to position RUN and press Reset button 

Select MCU: MB9BFD18S/T  
Select file (*.srec; *.hex) 
Select Virtual COM-port 
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Flash Programming via X11 or X12 (Serial) 

 FLASH MCU Programming via X11 or X12 (UART A or UART B) 

  Jumper setting 
 Check jumper setting: J14:2-3  (P60) 

− Connect the board via USB CMSIS-DAP (CN3) to the USB-Port of the PC 

 When connected for first time Windows OS may ask for 
‚spansionusbvcomm.inf‘ 
• <drive:>\drivers\cmsis-dap 

− Use the FLASH MCU Programmer for FM3/FM4 

 For installation <drive:>\tools\PCWFM3-V01L07\setup.exe 
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Select MCU: MB9BFD18S/T  
Select 4MHz Crystal Frequency 
Select file (*.srec / *.hex) 
Select Virtual COM-port 
Execute ‚Full Operation‘ 
  incl. stand-alone operations 
    - Download Kernel 
    - Erase 
    - Blank Check 
    - Program&Verify 

 Choose the right target MCU MB9BFD18S/T  

 Select JP51 and JP52 accordingly 

 Select 4MHz Crystal Frequency 

 Browse for the programming file (*.srec or *.hex) 
− IAR: see subfolder <project>\example\IAR\output\release\exe 

− ARM/KEIL: see subfolder <project>\example\ARM\output\release 

 Adjust the corresponding virtual COM-port 

 

 

 

 

 

 Set switch S1 to position RUN and press Reset button 

Flash Programming via X11 or X12 (Serial) 
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JTAG Debugger 
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JTAG adapter 

 SK-FM3-176PMC-FA contains an on-board JTAG debugger that can be 
connected via X11 (UART B) USB connector. 

 Board version v2.0 uses CMSIS-DAP 

 Board version v1.1 uses OpenOCD 
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JTAG adapter CMSIS-DAP 

 This starterkit includes an on-board JTAG adapter 

− Compatible to CMSIS-DAP 
http://www.keil.com/support/man/docs/dapdebug/dapdebug_introduction.htm  

− Select debugger CMSIS-DAP in your tool chain 

 Any other JTAG-adapter can be connected to X14, too. 

− The correct JTAG-adapter must be selected in the IDE toolchain  

 No jumper setting is required 

 Additional virtual COM port is provided by X11 (UART B) 

 For driver installation <drive:>\drivers\driverinstaller.exe 

 Please set jumper J19 and J20 accordingly 

 

CMSIS-DAP MB9BFD18T X11 (USB) 
JTAG 

SIN0/SOT0 

X14 (JTAG) 

http://www.keil.com/support/man/docs/dapdebug/dapdebug_introduction.htm�
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JTAG adapter CMSIS-DAP – within IAR EWARM 

Setup in IAR EWARM (1) 

 Navigate to project options: 

− Via Files-List 

 Right-click at the project 

 Select „Options...“ 

 

− Or via menu „Project“ 

 Select „Options...“ 
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JTAG adapter CMSIS-DAP – within IAR EWARM 

Setup in IAR EWARM (2) 

 Setup Project Debbuger Options 

− (1) Navigate to Debugger 

− (2) Select tab „Setup“ 

− (3) Select Driver „CMSIS-DAP“ 

 

 

− (4) Select in „CMSIS-DAP“ 

− (5) Select tab „JTAG/SWD“ 

− (6) Select SWD 

 

 

1 

2 

3 

4 

5 

6 
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JTAG adapter CMSIS-DAP – within Keil µVision 

Setup in Keil µVision (1) 

 Navigate to project options: 

− Via Project 

 Right-click at the project 

 Select „Options...“ 

 

− Or via menu „Project“ 

 Select „Options...“ 
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JTAG adapter CMSIS-DAP – within Keil µVision 

Setup in Keil µVision (2) 

 Setup Debug & Utilities 

− (1) Select tab „Debug“ 

− (2) Select „CMSIS-DAP Debugger“ 

 

 

 

− (3) Select tab „Utilities“ 

− (4) Select „CMSIS-DAP Debugger“ 

1 

2 

3 

4 
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CMSIS-DAP Firmware update 

 

 

 

 

 

Please see instructions contained in firmware update package! 
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 SK-FM3-176PMC-ETHERNET v1.1 offers on-board debugging via 
OpenOCD instead of CMSIS-DAP via X11 

− Connect the board on X11 to the USB-Port of your PC 

− Open OpenOCD 

− Select the sk-fm3-176pmc-ethernet in config file 

− Click on Start Debug 

 

Debugging with OpenOCD (Board revision 1.1 only) 

If necessary you can install 
or reinstall the drivers via the 
“Install driver” button 
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Debugging with OpenOCD (Board revision 1.1 only) 

 IAR Workbench configuration 

 

− Open the project you want to debug. 

− Go to Project->Options 

 

 

− Select Debugger 

− Select Setup 

− As driver select GDB Server 
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Debugging with OpenOCD (Board revision 1.1 only) 

 IAR Workbench configuration 

− Select GDB Server 

− Type 127.0.0.1 on the field of TCP/IP address 

 

 

 

 

 

 

 

− Start debug in IAR Workbench 
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IAR Embedded Workbench 

 

 Installation 

 Getting Started 

 Open Project 

 Build Project 

 Debug Project 
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IAR Workbench Getting Started 

 Install EWARM from IAR-CD or download latest version from IAR 
Website 

− EWARM size-limited (32k) or time-limited (full) Evaluation Version 

 http://supp.iar.com/Download/SW/?item=EWARM-EVAL 

 Start EWARM Workbench 

 Choose File → Open → Workspace 
− e.g.: <drive:>\sw-examples\ 

http://supp.iar.com/Download/SW/?item=EWARM-EVAL�
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IAR Workbench – Main Window 

 IAR Workbench 

− Workspace on left side 
of Workbench window 

 If hidden then View→Workspace 

− Source files on right 
side of Workbench 
window as tabbed 
windows 

− Project open 
File → Open → Workspace → *.eww  

− For new projects 
start with ‚mb9bfd1xt_template’ 
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IAR Workbench – Menu Bar 

 IAR Menu Bar 

 File Control 
(new, open, 
save, etc.) 

Edit Control 
(cut, copy, 

paste, undo, 
redo) 

Configuration 
Control 

(e.g. RAM or ROM 
debugging) 

Navigation Control 
(Find, Bookmarks, File 

Navigation, etc.) 

Build Control 
(compile, make, 

stop build) 

Debug Control 
(Breakpoint, start 
Debug w/ and w/o 

download) 
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IAR Workbench – Workspace 

 IAR Workspace Window 

 
Project Name 

Sub Folder Modules 

Main Modules 

Module Includes 

Project Description 

Project Built Output 
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IAR Workbench – Making Project 

 Making the Project 

− Use Make-Icon (      ), <F7> or 
Menu: Project→Make 

− Check for no errors in Output window 
below 

− Build errors are indicated by       or 
In Output window and Source view 
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IAR Workbench – Download to Target 

 Download to Target and Start Debugging 

− Use       Icon, <Ctrl>-D, or Project→Download and Debug 

− A new menu bar will occur on sucessful connection to target 

 
Reset 
Target 

Stop 

Step 
Over 

Step 
Into 

Step 
Out 

Next 
Statement 

Run to 
Cursor 

Run 

End 
Debugging 

Trace 
Control 
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IAR Workbench – Debug (1) 

 Source Window 

− The Source windows do not change contents but get additional information 

 Current line (PC): 

 Halted on Breakpoint: 

 Halted on Data break (example):   

 Disassembly Window 

− Shows ‘pure‘ disassebly view 

− Shows mixed mode view 
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IAR Workbench – Debug (2) 

 Watch Window 

− Watch 

 Expressions/Variables have to be added by user and are updated by 
Halt/Breakpoint 

 

 

 

− Quick Watch 

 The Quick watch allows the user to calculate and recalculate expressions 
even with variables 

 

 

 

 The drop down menu memorizes the last typed contents 
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IAR Workbench – Simulator 

 Simulator 

− Mark Project File in Workspace 

− Choose Project→Options 

− Choose Simulator in Debugger Setup 

− Start Simulator with usual      Icon 
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KEIL µVision 

 

 Installation 

 Getting Started 

 Open Project 

 Build Project 

 Debug Project 
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KEIL µVision IDE and Debugger Getting Started 

 Install µVision from KEIL-CD or download latest version from KEIL 
Website 

− Evaluation Version 

 https://www.keil.com/demo/eval/arm.htm 

 Registration required 

 Install ULINK-ME  

− Special installation is not needed, because ULINK-ME acts as a USB 
Human Interface Device (HID) and thus needs no extra USB driver 

 Install ULINK Pro (optional) 

− ULINK Pro needs an own dedicated USB driver located in: 
<Installation Path>\KEIL\ARM\ULINK 

 Start µVision 

 

https://www.keil.com/demo/eval/arm.htm�
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KEIL µVision – Getting Started 

 Choose Menu: Project→Open Project... 

− Browse to: <drive:>\sw-examples\mb9bf56xr_gpio-v10\example\ARM\ 

− Choose mb9bf56xr_gpio.uvproj 



59 © 2014 Spansion Inc.  CONFIDENTIAL 

KEIL µVision – Main Window 

 KEIL µVision 

− Project window on left side of 
IDE window 

 Choose: 
View→Project Window 
if hidden 

− Source files on right side 
of IDE window as tabbed 
windows 

− Output window on bottom 
side of IDE window  
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KEIL µVision – Menu Bars (1) 

 Menu Bar 1 

− Can be moved in bar window area or set floating 

 
File Control 

(new, open, 
save, etc.) 

Edit Control 
(cut, copy, paste, etc.) 

(indention, commenting) 

Navigation Control 
(Bookmarks + search, etc.) 

(Text search, search in files, etc.) 

Debug Control 
(Start/Stop Debug Session, 

set/remove/disable 
breakpoints, remove/disable 

all breakpoints) 

Project 
Window View 

IDE 
Configuration 
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KEIL µVision – Menu Bars (2) 

 Menu Bar 2 

− Can be moved in bar window area or set floating 

 
Build Control 

(Compile [Translate], 
Build, Rebuild, etc.) 

Download 
to Target 

Configuration 
Control 

(e.g. RAM or ROM 
debugging) 

Target 
Options 

Manage Books, 
File Extensions, 

Environment 

Manage 
Multi-

Project 
Workspace 

MB9BF51x Release 
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KEIL µVision – Project Window 

 µVision Project Window 

 Project Name 

Startup Code Subfolder 

Startup Code Source and Header Files 

Main Project Code Subfolder 

Main Project Code Source and Header 
Files 

Project Description Subfolder and 
Abstract File 
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KEIL µVision – Making Project 

 Making the Project 

− Use Rebuild Icon 
(      ) or 
Project→Rebuild all target 
files 

− Check for no errors in 
Output window below 

 

− Build errors are shown in Output window. 

 Can be double-clicked by showing the source line with a blue arrow 
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KEIL µVision – Debug (1) 

 Start Debugging 

− Download to target first, when MCU Flash does not contain the current 
application openend and built in the IDE 

 Use Download Icon (      ) or Menu: Flash→Download 

− Start Debug Session 

 Use Start/Stop Debug Icon (       ) or Menu: Debug→Start/Stop Debug 
Session 

− Ending Debug Session 

 Use same way as for starting debug session 
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KEIL µVision – Debug (2) 

 Debugging Icon Bar 

− During a Debug Session there will be visible a new icon bar 

 Reset 
Target 

Start/ 
Stop 

Application 

Step Control 
(Step in, out, etc.) 

Show 
Source/Code 

Line of current 
PC 

Show Windows (Command, 
Disassembly, Symbols, 
Registers, Call Stack) 

Show (multiple) 
Windows 

(Watch, Memory, Serial, 
Analysis, Trace, System 

Viewer) 

Tool Box 
(can be 

customized) 

Debug 
Restore 
Views 
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KEIL µVision – Debug (3) 

 Source View 

− The Source windows do not change contents but get additional information 

 Active Breakpoint 

Disabled Breakpoint 

Current Program 
Counter 

Current Cursor Line of 
Source Code 

Code Lines with 
compiled Instructions 

(dark grey    ) 



67 © 2014 Spansion Inc.  CONFIDENTIAL 

KEIL µVision – Debug (4) 

 Disassembly View 

− Mixed mode is selectable and deselectable 

 Active Breakpoint 

Disabled Breakpoint 

Current Program 
Counter 

Current Cursor Line of 
Code highlighted in 

yellow background (   ) 
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KEIL µVision – Debug (5) 

 Memory Window 

− Up to 4 Memory windows can be displayed in tabs 

− Memory is updated during runtime 

− Memory window tabs are shared with Watch windows 

 

 

 

 Register View 

− Register view is a tab of the Project window 

− Changes are highlighted in dark blue text 
background 

− Register tree knots can be expanded 
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KEIL µVision – Debug (6) 

 Variable Windows 

− Watch Windows 

 Up to 2 Watch windows are sharing their tabs with e.g. Memory and Local 
views 

 Updated during runtime 

 Any changes are highlighted in dark blue text backround color 

 Displayed values can be changed by user during break 

 

 

− Local View 

 The local view shares the tab with e.g. Memory and Watch windows 

 Any changes are highlighted in dark blue text backround color 

 Displayed values can be changed by user during break 
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KEIL µVision – Trace (ULINK ME) 

 Trace via ITM 

− Simple Trace views via Instrumentation Trace Macro is supported by 
µLINK ME 

 Records 

 Exceptions 

 Counters 
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KEIL µVision – Trace (ULINK Pro) (1) 

 Trace via ETM 

− Check settings in menu: 
Flash→Configure Flash Tools... Tab:Debug 

 

enables ETM pins 
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KEIL µVision – Trace (ULINK Pro) (2) 

 Instruction Trace 

− Real Time Trace recording 

− Output can be filtered by several ETM and ITM events 

− Trace buffer is held in PC memory and transfered to µVision on break 
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KEIL µVision – Simulator 

 Simulator 

− The Core Simulator can be selected by the menu: 
Flash → Configure Flash Tools... and then choosing Use Simulator 

− Look & feel is like using ULINK debugger 

− Controlable also with *.ini files 
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Finally 
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FM3/FM4 Seminar Motor Control USB Workshop Ethernet Workshop 
Please register here: http://news.spansion.com/seminars  

• Overview FM3/FM4 family 
• Memory  
• Peripheral resources  
• Packages  

 
• Processor architecture  

• Bus structure  
• Flash memory  
• Flash programming 

 
• Peripheral resources  

• Clock distribution  
• Timer  
• Interfaces  
• FM3 features  

 
• Development tool chains  

• IAR workbench / J-Link 
• KEIL µVision / uLink 
• Starter Kits  

 
• Practical exercises  

• Flash programming  
• Project setup/modification  
• Debugging  
• External interrupts  

• Introduction of Spansion MCU  
• Line-Up of microcontrollers 
  with motion control features  
• Performance  

 
• Introduction of motors types  

• ACIM             
• BLDC  
• PMSM  

 
• Introduction of control types  

• Sinusoidal commutation  
• Field Orientated Control  
• Space Vector Modulation  

 
• Peripherals of FM3/FM4 MCUs 

• Base Timer  
• Multifunction Timer  
• 12-bit A/D Converter  
• Quadrature  Position  
  and Revolution Counter  
• Interrupt Controller  

 
• Hands-on exercise / SW-Example 

• BLDC motor with hall sensor  
• PMSM motor with 
  field orientated control 

• Introduction of Spansion MCU 
• Line-op of USB MCUs  

 
• USB vs. RS232  

• Historical Background  
 

• Electrical Layer  
 

• USB Protocol  
• Enumeration Process 
(Descriptors & USB Settings)  
• Transfer Types 
•  Data Transfers  
• USB Class Concept  

 
• Software Driver Concepts  

• USB Host 
 

• USB Examples 
• Virtual COM Port  
• USB Descriptor Manager 

• Create Template Classes 
• Create Descriptors  

 
• PC software based on LibUSB  
 

• Special Use Cases  
• e.g. boot loader 

• Introduction of Spansion MCU 
• Line-op of Ethernt MCUs  

 
• Fundamentals of Ethernet 
 
• Ethernet  Microcontrollers 
 

• Hardware Design considerations 
 

• Software Design considerations 
 

• Communication layer models 
 

• The Internet Protocol suite 
 

• Web technologies  
   in embedded systems 
 

• Developing Ethernet applications 
• Tools and methods 

 
• Practical hints and advice  
  on FM3 Ethernet solutions 
 

• Hands-on training 

Workshops & Seminars 

http://news.spansion.com/seminars�
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Spansion Support 

 Please check the following website, for any available updates 

www.spansion.com  

 Please contact your local support team for any technical question 

America: Spansion.Solutions@Spansion.com 

China: mcu-ticket-cn@spansion.com  

Europe:  mcu-ticket-de@spansion.com  

Japan: mcu-ticket-jp@spansion.com 

Other: http://www.spansion.com/Support/SES/Pages/Ask-Spansion.aspx  

http://www.spansion.com/�
mailto:Spansion.Solutions@Spansion.com�
mailto:mcu-ticket-cn@spansion.com�
mailto:mcu-ticket-de@spansion.com�
mailto:mcu-ticket-jp@spansion.com�
http://www.spansion.com/Support/SES/Pages/Ask-Spansion.aspx�
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EU-Konformitätserklärung / EU declaration of conformity 

Hiermit erklären wir, Spansion International Inc., Germany Branch, Pittlerstrasse 47, 63225 Langen, Germany,  
dass dieses Board aufgrund seiner Konzipierung und Bauart sowie in den von uns in Verkehr gebrachten Ausführung(en) 
den grundlegenden Anforderungen der EU-Richtlinie 2004/108/EC „Elektromagnetische Verträglichkeit“  entspricht.  
Durch eine Veränderung des Boards (Hard- und/ oder Software) verliert diese Erklärung ihre Gültigkeit! 

We, Spansion International Inc., Germany Branch, Pittlerstrasse 47, 63225 Langen, Germany  
hereby declare that the design, construction and description circulated by us of this board complies with the appropriate 
basic safety and health requirements according to the EU Guideline 2004/108/EC entitled ’Electro-Magnetic Compatibility’. 
Any changes to the equipment (hardware and/ or software) will render this declaration invalid! 

Note: 
This evaluation board is a Class A product according to EN61326-1. 
It is intended to be used only in a laboratory environment and might cause radio interference when used in residential 
areas. In this case, the user must take appropriate measures to control and limit electromagnetic interference.  
All data and power supply lines connected to this starter kit should be kept as short as possible, with a maximum  allowable 
length of 3m. Shielded cables should be used for data lines. As a rule of thumb, the cable length used when connecting 
external circuitry to the MCU pin header connectors for example should be less than 20cm.  
Longer cables may affect EMC performance and cause radio interference. 
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Recycling 

 Gültig für EU-Länder: 

− Gemäß der Europäischen WEEE-Richtlinie und deren Umsetzung in 
landesspezifische Gesetze nehmen wir dieses Gerät wieder zurück. 

− Zur Entsorgung schicken Sie das Gerät bitte an die folgende Adresse: 

 Valid for European Union Countries: 

− According to the European WEEE-Directive and its implementation into 
national laws we take this device back. 

− For disposal please send the device to the following address: 
 

CCS Express GMBH 
c/o Spansion International Inc. 

Frankfurter Str. 83-107  
D-65479 Raunheim 

Germany 
 

 This board is compliant with China RoHS  
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www.spansion.com 

 Spansion®, the Spansion logo, MirrorBit®, MirrorBit® Eclipse™ and combinations thereof are trademarks and registered 
trademarks of Spansion LLC in the United States and other countries. Other names used are for informational purposes 
only and may be trademarks of their respective owners. 

 This document is for informational purposes only and subject to change without notice. Spansion does not represent that 
it is complete, accurate or up-to-date; it is provided “AS IS.” To the maximum extent permitted by law, Spansion disclaims 
any liability for loss or damages arising from use of or reliance on this document. 


	SK-FM3-176PMC-ETHERNET�
	Warranty and Disclaimer
	Overview
	Features of the microcontroller
	Features of the board
	Contents SK-FM3-176PMC-ETHERNET
	Test it
	Test it
	Hardware
	The Hardware (Top Side) – Function Overview
	Hardware
	Hardware
	Hardware
	Hardware
	Hardware
	Hardware
	Hardware
	Hardware
	The Hardware (v2.0 Top Side) – Jumper Settings
	The Hardware (v2.0 Bottom Side) – Jumper Settings
	Jumper
	Jumper
	Jumper
	Jumper – Connector selection for serial interface
	Jumper – Power the starter kit and the microcontroller
	Software
	Software Examples
	Software Tools
	Flash Programming
	Flash Programming
	Flash Programming via X7 (USB direct)
	Flash Programming via X7 (USB device)
	Flash Programming via X11 or X12 (Serial)
	Flash Programming via X11 or X12 (Serial)
	JTAG Debugger
	JTAG adapter
	JTAG adapter CMSIS-DAP
	JTAG adapter CMSIS-DAP – within IAR EWARM
	JTAG adapter CMSIS-DAP – within IAR EWARM
	JTAG adapter CMSIS-DAP – within Keil µVision
	JTAG adapter CMSIS-DAP – within Keil µVision
	CMSIS-DAP Firmware update
	Debugging with OpenOCD (Board revision 1.1 only)
	Debugging with OpenOCD (Board revision 1.1 only)
	Debugging with OpenOCD (Board revision 1.1 only)
	IAR Embedded Workbench
	IAR Workbench Getting Started
	IAR Workbench – Main Window
	IAR Workbench – Menu Bar
	IAR Workbench – Workspace
	IAR Workbench – Making Project
	IAR Workbench – Download to Target
	IAR Workbench – Debug (1)
	IAR Workbench – Debug (2)
	IAR Workbench – Simulator
	KEIL µVision
	KEIL µVision IDE and Debugger Getting Started
	KEIL µVision – Getting Started
	KEIL µVision – Main Window
	KEIL µVision – Menu Bars (1)
	KEIL µVision – Menu Bars (2)
	KEIL µVision – Project Window
	KEIL µVision – Making Project
	KEIL µVision – Debug (1)
	KEIL µVision – Debug (2)
	KEIL µVision – Debug (3)
	KEIL µVision – Debug (4)
	KEIL µVision – Debug (5)
	KEIL µVision – Debug (6)
	KEIL µVision – Trace (ULINK ME)
	KEIL µVision – Trace (ULINK Pro) (1)
	KEIL µVision – Trace (ULINK Pro) (2)
	KEIL µVision – Simulator
	Finally
	Workshops & Seminars
	Spansion Support
	EU-Konformitätserklärung / EU declaration of conformity
	Recycling
	Slide Number 79

